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Definitions/Acronyms/Abbreviations

Term/Acronym Definition

Center Participating Center

CRF Case Report Form

DMC Data Management Center

Patient Binder Compilation of all available CRFs for a patient
QC Quality Control

EDC Electronic Data Capture

System Overview: DFexplore and DFsend

DFexplore is a remote data entry tool that allows Centers to enter their patient trial data electronically and
allows Collaborative Groups to view the data that has been submitted to the IBCSG by their Centers. This
manual explains DFexplore View-only access and DFsend. Those that have view-only access will not be
able to change data or reply to queries in DFexplore.

A Coordinating Group may be responsible for submitting non-CRF data to DFexplore for their Centers.
DFsend is a simple internet app used to send PDFs (containing scanned data forms, reports and other
non-CRF documents) to the DMC for review and processing. It includes the authentication, encryption,
confirmation and tracking needed to meet today’s security and regulatory requirements, and provides a
cost-effective alternative to faxing.

System Requirements and Recommendations

Internet Connection Speed: A minimum of a DSL connection is recommended for DFexplore. A slower
connection will result in slower response times.

Operating System: DFexplore is available for direct installation on Windows 8 and 10, MacOS 10.12 and
newer.

Getting Access to DFexplore and DFsend

Download (recommended)

Instructions for downloading DFexplore and DFsend can be found on the IBCSG DF Resource web page
at https://www.ibcsgdmec.org/ibcsa/df/downloads.view.

DFnavigator

If you are unable to download DFexplore, it can be accessed via the web through DFnavigator at
https://dfp.fstrf.org/

NOTE: DFsend is not available via the web. If accessing DFexplore via DFnavigator, you must fax any
non-CRF data into the system. Please see “DFexplore Fax Numbers”, available on the IBCSG DF
Resource web page, for available fax numbers. You must also enter the server name each time you use
DFnavigator. The server name is “explore.fstrf.org”.

NOTE: The instructions in this manual apply to both the downloaded application and the web-based
access.
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DFexplore resources (including installation files), support and documentation are available at:
https://www.ibcsgdmc.org/ibcsa/df/ .

For trials using DFexplore, resources are also available on the IBCSG Member website, on the trial-
specific webpage under General Resources.

Logging in to DFexplore

1. The DMC provides you with your initial Login Name and Password. You will be prompted to change
your password the first time that you log in. If you have a Login Name and password from iDataFax
(iDF) assigned prior to June 2019, your iDF Login Name and password can be used for DFexplore.
Every 90 days, DFexplore displays a prompt to change your password.

2. Your password should not be shared with anyone and is intended for use by only the individual named
on the account.

3. If you have lost or forgotten your password, either:

e Contact datafax.user.support@fstrf.org or

e Go to: https://www.ibcsgdmc.org/ibcsg/df/ and click on Support/Reset Password

4. A new password will be sent to you within 2-3 business days.
To log in:

1. Double click on the DFexplore icon on the desktop to start DFexplore. The Login box appears. Verify
the “DFdiscover Server” field displays “explore.fstrf.org”. If not, type it in.

2. Enter your Login Name and Password.

(7}, DFexplore - DFdiscover Data Management = m} X
@ d f 2018 Version 5.1.0
DFdiscover Server| explorelfstr.org v ||

USername| |

Password | |

Login Help Cancel

NOTE regarding Proxy Server: If your IT department has installed a proxy server (to filter requests sent
to other servers on the internet) click the gear button to the right of the ' DFexplore Server' name to register
the proxy server. You may need to contact your IT department for the necessary information as your
firewall must allow connections to explore.fstrf.org. The port number used for DFexplore’s secure
communication is port 443.

a |

[ use Proxy Server

Proxy Type HTTP S0CKS 5

Proxy Server
Port
Username
Password

Save username and password

0K Cancel
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However, if you do not use a proxy server, you should connect directly to our DF server at explore.fstrf.org
and should leave the gear button dialog box empty.

The Login box contains a Help button for troubleshooting:
() DFexplore - DFdiscover Data Management - =} X [@

Qdf

Login Guide

Troubleshooting Guide

DFdiscover Server ‘ explore.fstrf.org Message: Server Unreachable. - Check server and/or your
Usemame‘ network connection
Password Possible Cause: There is no internet connection available or server
address/name entered is invalid.
Solution: Confirm that your internet service is functioning

Password Reset

properly. Confirm that you have correctly typed the
Login Guide

DFdiscover server name in the login dialog.
About DFexplore Otherwise, contact your DFdiscover Study
Coordinator or System Administrator.

Message: Unable to connect to the DFdiscover server. Confirm
that DFdiscover is available.

Possible Cause: DFdiscover is not running on the specified server or
DFdiscover's network service is not running.

Solution: Contact your DFdiscover Study Coordinator or
Svstem Administrator and confirm that the hd

Close

3. Click “Login.” You have officially logged in to DFexplore and a list of trials that you can access is
displayed.

[ DFexplore - DFdiscover Data Management - X%
i@' d f [y Version: 5.0.1
DFdiscover Server‘ hosted-1.dfdiscover.com v‘ i)

USemame‘d_mgrem ‘

Password ‘unuouoo ‘

Select a study and click OK.

Number  MName Status

906 Sandbox Yvonne available

E 980 Sandbox Demo Monica available

oK Help Cancel

4. Double click the appropriate trial or select a trial and click on ‘OK” or select the trial and press enter on
the keyboard.

Preferences

Once logged in, DFexplore has a number of options to view and navigate through the data. To view the
options, select “File” then “Preferences” from the menu bar or the shortcut list on the left side of the
Dashboard.

This opens up a Preferences window. There are many options you can choose to set your screens to your
preferences. In order to be consistent with the details in this manual, the following settings are
recommended.
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Preferences Window suggested settings:

Set Dashboard + asthe default view < Default View: Set the Dashboard as your
default view, to see a real time overview of
Center’s data/query submission and quality.

¥ Data Window

L] Expand all visits when a subject hinder is open

[ Display first page when a visit is open

[ Advance to next field after current field is filled

L] Open first task record when task set is built

[] warn before opening next subject when traversing task records
[ Retain scroll position when traversing task records

|:| Display date picker for current date field

Auto text ali  fi ber, date, and time field . . .
B S T T Fk, T Display metadata editor: This allows the Query,

] Di i < e

Display metadata editor panel S Reason, Missing Value, and Help-Study box to

eCRF background color appear on the right side of the screen. If not
#EAEAEL checked, the Help box is not displayed.

Custom color

v Image Window

Auto open/close as image is available/unavailable < Auto open/close and split screen: data top,
Display method image bottom: This allows DFexplore to
(0 toggle screen between data and image views display the image of any faxed CRF at the
(O split screen: data left, image right bottom of the screen and the data entered in the
(O split screen: image left, data right database at the top of the screen, so both are
@ split screen: data top, image bottom visible at the same time. If there is no fax image,

O split screen: image top, data bottom you see the database on the full screen.

(O sticky toggle: retain data or image view across records

» Record List

» Query Defaults
> List View

> Image View
» Reports View
v_Background Options Color: This enables the color features in
-Co|0r O black O w-hite ® color DFexplore. NOTE: For older trials (55 and below),
CRF Type AE Monitor - you may want to select white or black for the
background.

A

Auto Logout: This is set, by default, to 5 minutes.
You can choose an auto logout time up to 30
minutes.

A

Exit after minutes of inactivity

0K || Cancel
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File Edt View Window Help

Dashboard ) R A Sites B W Refresh when Dashboard becomes visible

~
Data entry and review
Records Count Query Category [] Al Pending Outstanding Resolved
Missed records o other 0 1 !
Pending queries 0
Shor se status
Lo G o Outstanding queries 52
Subject scheduling Resolved queries o
Pending reasons 0
Run reports
Rejected reasons 0
Run batch edit checks Approved reasons 7
Data View Tasks ®
Record Status (186) POLAR (59-19)

Topics

Pending (0) A phase Il open-label. multicenter, randomized trial of adjuvant palbaciclib in combination
Study help with endocrine therapy versus endocrine therapy alone for patients with hormone receptor
Missad (0) positive / HERZ-negative resected isolated locoregional recurrence of breast cancer
® Incomplete (140)

Final (46) Arm A
Palbociclib 125 mg/day orally for 21 days, followed by 7 days rest for 3 years from

2 S
ElE
E

2|

randomization
+

Query Status (52) Standard endocin therapy for at least 3 years from randomization
; ArmB

Pending (0) Standard endocrine therapy for at least 3 years from randomization
Outstanding (52)
Resolved (0) Randomization must take place within 6 months from the complete gross excision of the,
locoregional recurrence.

Reason Status (75)

Open image router
Pendi 0
Open new study I
Rejected (0)
V
- < >
Last refresh: May 29, 2019 9:48:52 AM

By default, the Dashboard shows metrics for all sites on a selected trial for which you have access. To
change the Dashboard to reflect a single site, or a subset of sites, click on the Filter ellipsis and choose the
sites you wish to see:

File  Edit  View  Window  Help

Dashboard (-] MAH Sites Il

review

Records

) =)
L
m

A E
M E
= k=
m [=T]
- =
m (=8
w

Pending records

: Missed records
Review reasons

v

View Shortcuts - In the left column, shortcuts are provided to commonly accessed functionality
and menu items (e.g. data entry and review, review queries, etc.).

Status Summary - Presented in tabular and chart format, the status summary is an overview of the
records and metadata in the current database.

The table cells and chart legends are interactive. Double-clicking any item builds a task to retrieve those
filtered data records and presents them in Data View. Task options can be modified in the confirmation
dialog before switching to Data View. If the table cell or chart legend item is related to a query, the Queries
View is presented,; if it is related to a reason, the Reasons View is presented.
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In the table of query categories and statuses, rows are categories (type of query such as missing, illegal,
etc.) and statuses (pending, outstanding, and resolved) are columns. By default, categories (and rows) that
have counts greater than 0 are displayed. To display all table rows, check “All” in the table header for the
Query Category column.

To select queries for a specific category and status, double-click the matching cell in the table. To select
queries for a specific category and all statuses, double-click the category label in the first column of the
matching row. In the task confirmation dialog, you can choose if the task records are displayed in Data
View or Queries View.

The Dashboard is interactive and can be refreshed at any time. If you would like to have the dashboard
refresh every time you view the dashboard there is a box you can check next to the refresh button (see
image below).

File Edit View  Window  Help

Dashboard IR Filter by! B Refresh when Dashboard becomes visible

Data entry and review f 4
Recofds Count I:

Missed records i 1

Incomplete records 139 C
Final records 45 v
Pending queries 1] C
Outstanding queries 52

Filter by Center- Above the table of records, there is an option to filter by sites. Click on the box to select
a Center from the list. Select a Center and press OK.

Viewing Data

To View Center data, select “Data entry and review’ from the tabs on the left side of the Dashboard View.
You will then see a list of Centers (referred to as ‘Sites’ in DFexplore). Double click the Center to bring up
a list of patients enrolled under that Center. Double click on the patient icon to open the patient binder.
Inside the binder is a list of all forms for the patient. If your Group is a Coordinating Group, you see all
Centers (and patients) from your Group. When you are finished viewing data, double click on the visit or
patient icon to close.

Centers are listed in the order they entered the trial. Site Number (if shown) is the DFexplore Number for
that particular Center in this trial.

Within 24 hours of patient randomization via the IBCSG Registration/Randomization system, the patient
binder will appear under the appropriate Center listing in DFexplore.

a

7 site 1 - TEST

AE Site 0 - Error Monitor (Error Monitor) I.I% 500001
o _.
o Site 1 - TEST 0e
590002
5 Site 2 - Monica UD
12, 520003
12 s00004
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Navigating through DFexplore

The DFexplore data screen consist of six sections (Center/Patient binder, Data screen, Query box, Reason
box, Missing value box, and Help box):

File Edit View Select Show Subjed Vist FPlste Field Window  Help

22 Site 0 - DMC (Error Manitor) " Reported Value
2fosit= 1 - TesT Categary
12 sso001 use
& 550002 Type K
12 550003 Status
& ss0004 Detail
1.2, 550005
12 550007
{12 ss0008
12 sso000 L)
§& 550010 i
®
& 550011 Patient Data Entry
2 550012 i
s Binder Screen
{2 550013 Status
{2 550014 N =
& 550015 I
12 sso016
& 550017
12 ss0018 | ¥ Missing value |
(& ss0023
o [Creh s EAEENET
& 550025 IBCSG Trial 55-19 TOUCH =
12 550026 TOUCH fs a Phase || opan-dabel, mullicenter,
randomized trial for elderly patients with hormene
{2 sso027 receptor positive’HER2 positive early breast
18 550028 cancer
& 550029 Arm A:
1.2 ss0030 Paclitaxel 80 mg/m? i.v. on day 1.8.15 every 28
e days for 4 cycles.
12 sso031 < > |
Trastuzumab 600 mg s . every 3 weeks for a total
12 550032 - nal Incomplete Pending & | of § doseis
Switch to List View

Patient Binder

The Patient Binder lists all patients enrolled for that trial, at the Center. Each patient is represented by a
Patient ID and, to the left, a head icon.

The subject binder colors and icons -
correspond to the page Save status: s _
Subject icons:
12 Green, filled scale No problems, all pages with status final
12 |Red, half-filled scale At least one page with status incomplete
Orange, outline scale At least one page status pending, none incomplete
Grey, dashed outline scale |All pages marked missed (i.e. unavailable)
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Double click on the patient icon to open the patient visits and CRFs, ordered by visit (e.g., Baseline,
Treatment Cycles, Follow-up, SAEs etc.).

590001 - 1 of 843
Ste 0 - Error Monitor (Error Monitor)
2% site 1 - TEST

Data Screen

Data is entered on these screens by the Center. Each screen is a page of a CRF. Trials that were set up in
iDataFax and migrated to DFexplore (IBCSG 55 and lower) retain the old backgrounds:

Plate #001
IBCSG =
Patient D | 290160 Center Code

CONFIRMATION OF RANDOMIZATION FORM (Form 55-A)

Instructions: Complete this form to de tis eligib

formance Status of 0 or 17

e. |s the patient umor HER-2 pos

The background color can be changed from black to white by going to File > Preference ->Background
Options. The white background may aid in viewing the field colors more easily.

Page 9 of 23



IBCSG DFexplore User Manual for View-Only Access
Version 2.0 May 2022

Trials set up in DFexplore have a background where colors and shading are used to aid in navigating and
understanding the questions.

HISTORY FORM (59-H)

Demeographics

1. Age at randomization

]

Vitals
2. Height (cm) 3. Weight (kg) 4. ECOG Performance Status

] [ ] b

Do not report decimal

5. Was a pregnancy test performed at screening?

© No, not of child-bearing potential O Yes — g Date of test

If any data is submitted to DFexplore via DFsend or fax, a split screen is displayed, where both the fax and
the data entry screen are viewable.

Study 252 (SE) 101 Subject Encounter

I:\ Missed scheduled visit —# £End of form.
1. Type of visit
@ Scheduled —p Gotoitem 2.

O Unscheduled

1a. Besides this form, which CRF's were completed for this unscheduled visit? (Mark all that apply or "None”)

[0 ~one [ Lab Results

mp3 [ Reactogenicity

O cm [J Adherence

[ Vital Signs O Acceptability Assessment

[ Physical Exam [J other, spesify: ‘ ‘

1b. Reason for unscheduled visit. (Mark al that apply.)

[ Adverse Evant O other, speciy: ‘ ‘

2. Did the subject return study medication?

@® Yes O No, explain: | —»  Goto item 3.
e e | | N A Ly Bl W WL L et Wt M 5

!
| DFINet Study 252 (SE) 101 Subject Encounter

[ Missed scheduled visit — End of form.
1. Type of visit
[ scheduied —»  Go to item 2

\ [ unscheauted

1a. Besides this form, which CRFs were completed for this unscheduled visit? (Mark all that apply or ‘None’)

[ none [] Lab Resuits

O 4e [ Reactogenicity

Oem [] Adherence

[ vitar signs [ Acceptavitty Assessment |
[ Physicar Exam [ other, spociry I

m for unscheduled visit. (Mark all that appiy.)

M othar snaci
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If the image can not be seen, select the toggle display box )

D) DFexplore [greco@dench fstri.org] IBCSG 59 - POLAR - All Records

File Edit View Select Show Subject Vist Plate Field Window  Help
[so0001 - 10 0f 793 [i]m] ~
{3 : Confirmation of Rando... 40: Pathology Report (59-PR)
M4 : confirmation of Rando... o
B 10 : History Form (S8-H) p1
! rrem e Assessment Humber
M 11 : History Form (59-H) p2
{12 : History Form (59-H) p3 e
{13 : History Form (59-H) p4
History Form (59- Center Code Site 1 ©
< >
: Master Plate (59-Ma... Patient Number: 6325 Gender: Female ~
§M 150 : Randomization (59~ RepoctDate:  TaM20TLLLISEAM.
¥ 151 : Randomization (36-... Result Value Previous) Units
{8479 - Country (59-Cntry) COMPREHENSIVE METABOLIC PANEL .rocovpiere  Ordered by: JAMI
157 : Randomization Resl... Comments: CEC RUN INITIALLT- CHANGED TO CBCONC PER
| 158 : Tdealized Schedule (... 1121 Jomt
SODIUM 134 MEQL
18 : Correspondence (5
) , POTASSIUM 39 MEQL
) 485 : Lost to Follow-up e = ol
v {1 TX Month 1 coz 23 mmol/L
{9 20 : Adverse Event Form (... AG 1
21 : Adverse Event Form (.. GLUCOSE 95 MG/DL
)22 : Adverse Event Form ( BUN 23 mg/dl
123 : Adverse Event Form (. CREAT 08 MG/DL
24 : Adverse Event Form (.. EETOER I ATRICAN >60 see note
125 : Adverse Event Form ( ST GLOMERULER.
. . >60 see note
26 = Adverse Event Form (. FILTRATION RATE
A Note: Normal > E = &0 mL/min/1. 73m s
27 : Adverse Event Form (..
- ¢ Chronic kidney disease 15-60 mi/min/l.73m squ,,
: Adverse Event Form (. i ey e e
< >
: Adverse Event Form ( l -
m[1—+1 Final Incomplete Pendin 2
(330 : adverse Event Form (., ¥ | |TE 1 L 2 =

Switch to List View

- >

at the bottom right of the data entry window.

Status

Category

Reported Value

Category -
Use s

Type v

Status
Detail

Note

Reply

o

Status
Reason

I

Image display box

Last Save: 5/13/2019 09:13:17

If there are multiple pages of an image, these can be pulled up by selecting the numbered box at the

bottom right side of the data entry screen.

{0 DFexplore [greco@denebfstrf.org] IBCSG 58 - POLAR - All Records

File Edit View Select Show Subject Vist FPlate Field Window  Help
590001 - 10 of 792 [iw]m] ~
{3 : Confirmation of Rande... ~ 40: Pathology Report (59-PR)
{8 4 : Confirmation of Rando SrE
10 : History Form (59-H) p1
v v o ey PR
{8 11 : History Form (59-H) p2
{8 12 : History Form (59-H) p3 Patient ID
8 13 : History Form (59-H) p4
History Form (59- Center Code Site 1 .
40 : Pathology Report (5¢ < >
480 : Master Plate (59-M Patient Number: 632 Gender: Female &
7/5/21
{0 150 : Randomization (50-... Repaorfillate:: 3RALLATIEM
{8 151 : Randomization (59-... Result Value (Previous) Units
ol 479 : Country (59-Cntry) COMPREHENSIVE METABOLIC PANEL _r-compiers Ordered by: JAMi
157 : Randomization Resul Comments: CBC RUN INITIALLT- CHANGED TO CBCONC PER
| (158 - Mealized Schedule (... 1121 JKEHT
SODIUM 154 MEQL
118 : Correspondence (59...
) 0 . POTASSIUM 39 mEQL
(485 : Lost to Follow-up/Wi CHLORIDE 107 mEQUL
v g1 T Month 1 co2 23 p—
4 20 : Adverse Event Form (... AIG 4
121 : Adverse Event Form (. GLUCOSE 95 MG/DL
)22 : Adverse Event Form ( BUN 23 mg/dl
23 : Adverse Event Form (... CREAT 08 MG/DL
X EST GFR IF AFRICAN L
124 : Adverse Event Form (. s =60 see note
] 25 : Adverse Event Form ( EST GLOMERULAR
, > 60 see note
26 : Adverse Event Form (... FILTRATION RATE
A Note: Normal > E - €0 mL/min/1.73m s
27 : Adverse Event Form
— . ¢ ddney disease 15-6€0 mi/min/l.7im squ,
(028 : Adverse Event Form (. e EeiTeo
< >
29 : Adverse Event Form (...
= mi1—1] Final Incomplete Pending
0 : Adverse Event Form (.. ¥

Switch to List View

Last Save: 5/13/2018 09:13:17

Status

Category

Reported Value

Category 5
Use N

Type \

Status
Detail

Note

Reply

I

Status
Reason

e

v Missing valve ]
- e NUMber of fax

images
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The image box expands showing a list of images saved in the database. Click on each one to view each
page.

[ DFexplore - Review Images ? X

Window  Image ID Type Arrival Status Sender Primary

1919/0005001 CRF 2019/05/13 09:10:07 _seconda DFexplore Import PDF:greco:PATHOLOGY REPORT.ex.pd

1919/0004001 CRF  2019/05/13 09:09:27 *primary  DFexplore Import PDF:greco:Meteora Lab Reports_Redacted.pdf e
Delete
Reset
A
PATHOLOGY REPORT
PATIENT ID: 450200
CENTER CODE: ANZTEST
I
I HER2/NEU: HER2 is positive
Description of excision of the bulk of the primary tumer frem which a histological type is described:
Breast adenocarcinoma that is unresectable loco-regional
Most extensive surgery to the breast: Mastectomy
Axillary clearance: was done and margins are looked at. See following report.
Hormene receptor status: ER and PgR are positive
v
Split | No - Apply Cancel

Query Window
This window is for query management (creation, replying and resolving) by the Center.
Reason Window

This window is used to provide a reason when a change is made to saved data. This can also be used to
provide additional information or clarification to a data field used by the Center.

Missing Value Window

This window is for reporting a value that is unknown, unattainable, etc. by the Center.
Help-Study Window

This window provides help at the study, page (plate) and field level.

Color Coding

DFexplore uses different colors to provide information about each field. The chart below explains each
color that is used in DFexplore.

The color coding chart can be found under the Help tab in the toolbar.

()
Help

Topics Field color coding in DFexplore
Certificate Info t white JlElet Legal, optional and blank value
Color Coding P blue  Outstanding query, rejected query or reason
Task Instructions red lllegal value, required but blank value, missing value

code in essential field
Show Roles

orange Pending guery or reason

Study He\p areen Resolved query, approved query or reason, missing

value

About DFexplore
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Selecting Centers in iDataFax

1. To obtain a set of data for one specific Center, select View = Data from the toolbar.

View  Select  Show  Subje
Dashboard Ctrl+1

Image Ctri+I

~ Data Ctrl+D
Queries Ctrl+U
Reasons Ctrl+R.
Reports Ctri+E
Schedule Ctrl+Shift+S
Status Ctrl+5
List Ctri+L

Batch Edits Ctrl+Shift+B

2. Then click on Select > By Data Fields from the toolbar to bring up a dialogue box.

Select  Show  Subject  Visit
~ Al Records...

By Task.

By Data Fields...

By Data Retrieval File...

Define Tasks...

Export Tasks to Local File
Import Tasks from Local File...
Change Mode & Level...

Batch Validate

Batch Sign

3. Click on the “...” button to the right of the “Site” field to bring up a list of all Centers for which you have
access.

a
Mode View -
Save Level 6 - Level 6 Enable edit checks
Search @® Data O Query O Reason O By program
Status [ Final [ Incomplete [ pending [ missed
Site ‘ I
Subject ‘ 1
Visit ‘ | =
Plate \ (7 DFexplore - Sites... ? >
Level ‘

Number Name
Creation ‘ DMC (Error Manitor)
Modification ‘ 1 TEST
geien ‘ 2 CONDMAP
Expression 3 9090--

Clear Done

4. To sort by the Center Code in alpha-numeric order, click on the “Name” title at the top of the box.

5. Select the Center Code you would like to view, and click the “Apply” button. The DFexplore Center
number will appear in the “Site” box.

6. Click the “Build Set” button and then “OK” to obtain a set of data containing all the patients for that
Center.
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Accessing Queries

To create a list of all outstanding queries:

1. Click the “View” drop down menu on the tool bar.
2. Select Queries.

View Show Query  Windc
Dashboard Ctrl+1
Image Ctrl+1

] Data Ctrl+D

T ¥ Queries Ctrl+U
Reasons Cirl+R
Reports Ctri+E
Schedule Ctrl+Shift+5
Status Ctrl+S
List Ctrl+L
Batch Edits  Ctrl+Shift+B

3. Alternatively, queries may be selected from the Dashboard View in one of two ways:

Data entry and review

Review queries

Review reasons

Review data and metadata
Show database status

Run reports
L

Sele UasILUAIU LUIENLS

Records
pending records
Missed records
Incomplete records
Final records
Pending queries
Outstanding queries

Resolved queries

Count

1568

‘ Query Category [] All Pending | Outstanding

Missing 1 4
Tlegal 1 0
Inconsistent 0 1
Other 1 1
Missing Page 0 1216
verdue Visit 0 330
EC Missing Page 0 16

3.1. Clicking on the “Outstanding” queries column takes you to the individual queries on the data field.
3.2. Using View > Queries or clicking on “Review Queries” on the left, shows queries as follows:

A list of all queries for all patients on the trial are displayed. Queries with a green icon have
been resolved and require no further action. Queries with a blue icon require a reply from the
Center. Pending queries are indicated with an orange icon. These are awaiting DMC

All queries

Outstanding
queries only

approval.

You can narrow the list of queries are displayed (e.g., all queries, only outstanding ones, etc.)
by selecting the “Show” drop down menu on the tool bar.

Select the desired option.

File  View Show Query  Window

Task Queries

Site [ Subject All Queries

12002 10 outstanding Queries

| 250003 Resolved Queries
Pending Queries

| 250003 el
Query Category

250003 Data Correction Queries

Data Clarification Queries

| 250003
Search Queries...

Help

Outstanding Queries Modified in the Past >
Outstanding Queries Modified More Than  »

Site 250 - 122 outstanding (

aphics

aphics

aphics

nent

Field : Category
Qverdue Visit

Visit Number := 000 (Missing)

Birth Date : (Missing)

Detail: Birth Date is a required field, but
currently it is blank. Please review.
Ethnicity 1= Not Hispanic or Latino (Missing)
Detail: Please rcorrect

3. Date study drug dispensed := 02/JAN/2018

(Inconsistent)
Detail: The response to 3. Date study drug

Status & Replies
Outstanding (New)
Modified by: d_mgreco 2/7
Outstanding (New)
Modified by: d_mareco 3/2
Resolved corrected
Resolved by: d_mgreco 3/:

pending
Modified by: d_mgreco 3/2
Outstanding (New)

Modified by: diare 5/9/201:

dispensed is expected to be greater than or equal
to 1. Date subject signed consent farm, Please

Site 200 - 4 outstanding queries modified

Site / Subject Wisit : Page

Field : Category

Status & Replies

& site 200 - Frontier

H 200001
u 200001
H 200001

u 200001

Screening : DM: Demographics
Enrollment : ENR: Enroliment
Adverse Event Page 02 : AE: 227

Adverse Event Page 03 @ AE: 727

Birth Date := 02/JAN/1985 (Illegal)

Visit Date : (Missing)

Detail: TEST Query

SDV Check := Unchecked (SDV Query)
Detail: SDC Review Required

SDV Check := Unchecked (SDV Query)
Detail: SDC Review Required

Outstanding (Mewr)

Modified by: kitty 1/23/2019 18:27:40
Outstanding (Mew)

Modified by: KScott 2/8/2019 11:58:15
Outstanding (New)

Modified by: KScott 12/3/2018 11:45:36
Outstanding (New)

Modified by: KScott 1/17/2019 08:20:59
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4. Double click on an individual query line to open the patient binder to the CRF page that has the query
and the field where the query is placed.
5. To return back to Query View, click on the “Return to Query View” bar located below the patient
binder.
Hémnm
6. When you are done with Query View, you can return to the patient binder by selecting View - Data.
QC Reports

Quality Control Reports are distributed on a regular basis via email. The QC report should be sent to the
Center. The Report contains a list of overdue forms and, for some trials, a patient summary status. With
DFexplore you can view overdue queries and CRFs in real time and Centers have a chance to answer
them before the next QC Report is generated.

For older trials, Centers’ outstanding queries may also be sent. Centers can either answer the queries on
paper and send the response back via DFsend or fax, or answer the queries directly in DFexplore.

Centers do not need to do both.

List View

List View allows you to view data records for a selected CRF page in spreadsheet form for all patients.
Each row in the spreadsheet is a data record and each column is a data field. This data can be searched
and sorted. In List View, the data can be exported (Click File > Export Data) to various Excel formats.

You can access List View from Dashboard View by clicking on the Review Data and Metadata tab:

File  Edit View  Window  Help

Dashboard (] IR Al Sites ! Refre

Data entry and review

Records
Review queries Pending records
Missed records

Review reasons
Incomplete records

Review data and metadata

Final records

Show database status Pending gueries

Outstanding queries
Run reports Resolved queries
Data View Tasks Pending reasons
Rejected reasons

Approved reasons
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List View can also be accessed from the toolbar at the top. Select “View” and then “List”. This opens up a
window showing all CRF pages available for that trial.

File Edit | View  Select Show  Page
Dashboard Ctrl+1

Image Ctri+I
Data Ctrl+D
Queries Ctrl+U
Reasons Ctrl+R
Reports Ctri+E
Schedule Ctrl+Shift+S
Status Ctrl+s

~  List Ctri+L

Batch Edits Ctrl+Shift+B

When one page is selected, a table replaces the data window. The table lists each field on the page and
the data entered in DFexplore for each patient.

File Edit  View Select Show Page Field ‘Window Help

Plates & Metadata Modules DFSTATUS  DFVALD DFRASTER  DFSTUDY DFFLATE VISITNUM SUBJD  VISDAT  MHSFID MHTERM MHSTDAT ~ MHENDAT
[250001,201,200] - 1 of 10 11 1st Pass Entry 1737R001G001 252 200 201 250001 20101  SEPSIS 12/MAR/2000  12/MAY/2000
001 - DM: Demographics 2 final 1st Pass Entry  1819R002P014 30 200 201 250005 04/MAY/2017 20101 left knee sprain 03/APR/2017
010- I I”C‘US‘T‘” Exclusion 3 final 1st Pass Entry 1819R002P034 30 200 201 250007 01/MAY/2018 20101  right arm fracture 23/JUN/2002  15/NOV/2002
020 - ENR: Enroliment
025 - RAN: Randomization 4 final 1st Pass Entry 1738R0006028 252 200 201 350001 20101 Obstructive sleep apnea 02/MAY/2009
030 - VS: Vital Signs 5 final Ist Pass Entry 1738RO00MO07 252 200 201 350003 20101 Tubal ligation 00/000/1897  00/000/1897
031 - VSe: Vital Signs eCRF 6 final 1stPass Entry 1738R000NDOL 252 200 202 350003 20201 Pancreatitis 00/000/2001  00/000/2001
040 - PE: Physical Exam
050 - LB: Hematology Results 7 final Lst Pass Entry  1819R003G008 30 200 201 350004 01/MAY/2018 20101  asthma 06/2UN/1990
060 - CCPR: Cardiac PCIReport 8 final 1st Pass Entry  1819R003H032 30 200 201 350005 01/JUN/2017 20101  flu 04/FEBf2017  15/FEB/2017
101 - SE: Subject Encounter o
110 - SADH: Study Drug Adherence 9 fina 1st Pass Entry  1819R0031018 30 200 201 350008 01/FEB/2016 20101  pneumonia 23/ANf1991  12/FEB[1891
120 - AA: Acceptability Assessment 10 final 1st Pass Entry  1819R003HO076 30 200 201 450007 01/MAY/2018 20101  arthritis 08/SEP/2013
130 Reactogenicity

Any column can be reordered in ascending or descending order by clicking on the field in the top row.
Double click on any field in the table to go back to Data View where the page/data can be seen.

The fields can also be color-coded to match the data (blue for fields with queries, green for resolved field,
etc.). To activate this option, choose “File” from the tool bar and “Preferences” from the drop-down menu.
Under “List View” click on “Fill cell with field color” and then click “OK”.

Display field name as® name O alias [ number : namefalias

Display coded field asC) code @) label

Display date field as ® default O calendar O julian apply imputation rule
Fill cell with field color I

[ Expand text fields

All fields on that page are displayed in a line; one line per patient. To reduce the number of fields seen,
click “Select” from the toolbar and then “Field Selection”. A pop up box with all the fields is displayed.

1. Click on “Select None” and then individually select the fields you want to review.
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2. Click “OK”. The screen shows only the fields you selected.

2) DFexplore - Field Selection ? X
Page: 020 - ENR: Enrollment

Field Name Alias Description Type  Format Le¢ ™
O 2 DFVALID DFvalid20 Validation Level choice 0~
[l 3 DFRASTER DFraster20 Image ID string
O 4 DFSTUDY DFstudy20 Study Mumber number
O 5 DFPLATE DFplate20 Plate Number number
O [ VISITNUM VISITNUMO20  Visit Number number
e N T N
8 VISDAT VISDATO20 Visit Date date DD/MMM/YYYY 01/
O 9 ENRDAT ENRDAT 1. Date subject signed consent form date DD/MMM/YYYY 01
O 10 ENRPROTMUM ENRPROTNUM 2. Under which protocol did subj consent number n.n 1.0
O 11 ENRDRUGDAT ENRDRUGDAT 3. Date study drug dispensed date DD/MMM/YYYY 01
O 12 ENRKITNUM  ENRKITHUM 4. Study drug kit # number nnnn 100
O 13 ENRBOTNUM ENRBOTMNUM 5. Bottle # number nn 1-1
O 14 ENRDESC ENRDESC Comments string
O 15 VHNUM VNNUMO20 Version Number number n.n
[l 16 VHDAT VNDATO20 Version Date date DD/MMM/YY
O 17 sDV SDV_020 SDV Box check
O 18 DFSCREEN DFscreenstat20 Screen Status choice 0~
O 19 DFCREATE DFcreate20 Creation Date string
O 20 DFMODIFY DFmodify20 Modification Date string v
< >

Default Revert

Select All | Select None I

Searching a Field in List View

The Search function in List View can be used to find records with a specific data value or attribute.

1. While in List View, select the plate you would like to search.

Choose “Select” from the toolbar and then “Search”.

2
3. Click on the “...” button next to the Field # box, and choose the field you would like to search.
4

Specify the data you are searching for, check the “Filter” box and click “Filter”. A dialogue box

pops up with the results of the search. To view these filtered records, click “Apply”.

The example below is a search on an Enrollment Form. It is looking for all patients that were randomized

on 01 May 2018.

L2 Derplore - Seatch
Data Fiekis
Faide 3
vale  Dlilegal Dlmissng [ blank required
o] equals [ contains[01/May/2018
or QuenyT] pending [ outstanding [ resolved

andD] esternal ) intemal
andcontains

or Reasonl ] pending [l rejected [ approved
and contains

Data Records

stows Ol Dincomplate [ pording [ missed

site

Subject

visit

Level

Crestion

Madfication

Expresson

0 8y Frogram

Resat

7%

Drraction

oone
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The selected records appear in the window.

File  Edit  View  Select Show  Page  Field window  Help

Plates & Metadata Modules DFSTATUS DFVALID DFRASTER  DFSTUDY DFPLATE VISITNUM SUBJID VISDAT ENRDAT
[250007,1,20] - 1 of 2 filtered records 11 1st Pass Entry 1819R002P020 30 20 001 250007 01/MAY/2018 01/MAY/2018
001 - DM: Demographics |2 final 1st Pass Entry  1819R003HO66 30 20 001 450007 01/MAY/2018 01/MAY/2018
010 - IE: Inclusion Exclusion

: Enrollment

Reports

DFexplore has many reports that aid in understanding the data in DFexplore (compliance, accrual, etc.).

To run a report, select “Reports” from the “View” tab or select “Run Reports” from the Dashboard View. A
list of report options appears.

NOTE: Some reports are accessible based on role permissions. You may not be able to run these reports
and they will not be in the list when you open the Reports menu.

File  Edit  View  Select  Window
quDFdiscover Reports
v Site Tracking
Enrollment by Site
Visits by Site
CRFs by Site
Queries by Site
2UPIe 5 Sitequenes]
Subject Scheduling
Query Reporting
Study Setup
Database Status
Query and Data Trending
Legacy Reports

Click on a report option. From the drop down, select the data options to specify in the report. Click “Run”.

File Edit  View  Select  Window  Help

E,%DFdiscuver Reports Name |Enro|lment by Site
~ Site Tracking Options | Clear Options
Enrollment by Site Spacify Clear Options
5 -visit <#> ...Use the specified visit as the enrollment visit
Visits by Site -plate <#> ...Use the specified plate as the enrollment plate
CRFs by Site [
Queries by Site Run Explain Close Report
Subject Tracking

Subject Scheduling
Query Reporting
Study Setup

The reports are interactive and clickable output can be manipulated and displayed in different ways without
re-executing the report. They can be pulled off the DFexplore screen (click on the report and drag it off
DFexplore window) and you can continue to work in the database. Reports can be printed and saved in
different formats.

Page 18 of 23



IBCSG DFexplore User Manual for View-Only Access
Version 2.0 May 2022

If you select Options on the right side of the report, additional features can be viewed.

Fle Edt  View Sekea  Window  Help

(B8 oFdscover Reports

¥ Site Tracking

Name | Visits by Site
Options Ciear Options

Enroliment by Site Specfy
Visits by Site
CRFs by Site
Queries by Site Run Exploin Closa Regort 21| visits by Site
Subject Tradkng —
‘Visits by Site & x

Subject Scheduling
Query Reporting
Study Setup
Datsbase Status
> Query and Data Trending
L

egocy Reports

] History

911 - Sandbox Template

Visit

Visits by Site

Womez 3

Wowes 5
—
: W wc s

W OFMet Test 0

Date: 2019-05-09
Time: 15:29:27

W Clinic 2
™ Clinic 3
W Clinic 4
W DFNat Tast

: H
Humber of Visils

@
Z
=
£
o

File Edit View Selet Window Help
(B8 oFdecover Reports Name. [vists by Site
~ Sita Tracking Options | Ciear Options.
Enroliment by Site Spey
Visits by Site
CRFs by Site
Queries by Site Run Explain Close Report %) Visits by Site
Subject Tradang -
> Subject Scheduling el
Query Reporting
Study Setup 911 - Sandbox Template Visits by Site

Database Status

> Query and Data Trending
Legacy Reports

i

£ History

Reports can be saved in PDF, Excel, and HTML formats.

Number of Visits

@ = ] ™ 80 ] 100

Visit

Saving Data from DFexplore

You can save blank forms for each patient to use as a worksheet, or copies of completed forms for

reference as PDF files. A single page or the entire binder can be saved.

NOTE: Files saved as PDFs are not viewable by the DMC. Saved files are to be used for Center reference

only.

1. Open the appropriate patient binder.
2. Select “File”.
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3. Select “Save as PDF”.

) DFexplore - Save as PDF ? b

Selection Criteria
O Blank CRF books
current subject subject
all visits visit
all plates plate
print visit numbers include optional | | visits plates
@® Data and images
® current plate O current visit
O current subject O all open visits
current task set
Save Options
[ Blank plates
Data records
[ expand text fields for plates
[ data + primary image (side by side)
O 1mages
primary only
all images

[ Apply field color for completed plates

Qutput File

Save Cancel

4. Select the appropriate options (see Printing from DFexplore above for descriptions of most of the

options)
5. Click on the button in the Output File section to choose the location to save the file.
6. Click “Save”.

Printing from DFexplore

While saving data as a PDF is more environmentally friendly and can reduce the risk of HIPPA violations,

you also have the options to print blank forms for each patient to use as a worksheet or copies of
completed forms for reference. A single page or the entire binder can be printed.

1. Open the appropriate patient binder.
2. Select “File”.

3. Select “Print”.

4. Select the appropriate options:

4.1. The Selection Criteria section allows you to determine how much of the patient binder will be

printed:

e Blank CRF books: Allows you to print blank CRFs by patient, visit or page (plate)

e Data and images:
o Current Plate: Prints only the page that is open in the data window.
o Current Visit: Prints all pages in the visit period that is open in the data window.
o All Open Visits: Prints all pages in every open visit period (i.e., all CRFs for that

assessment can be seen).
o Current Subject: Prints all pages in the selected patient binder.
4.2. The Print Options section allows you to determine what types of images are printed:
e Blank plates (pages): Prints a blank copy of the selected pages.
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NOTE: The Patient ID and Month/Cycle/Visit Number are completed on every printed
page, even if “Blank Pages” is selected. Verify that the correct patient binder is selected
before printing.

e Data records: Prints pages with data. The data and primary (data submitted by DFsend or fax)
images can be printed side by side.

e Images: Prints any images submitted by DFsend or Fax. If more than 1 image is held on the same
page, one image is assigned as primary and all others are secondary. If you want to print all
images for that page, select “all images”.

e Apply Field Color Option: Clicking this box applies the colors for each field (e.g. blue for
outstanding query, red for required/illegal field, etc.)

5. Click “Print”.

Switching Between Trials

If your Group participates in more than one trial in DFexplore, you may close out of one trial and open
another by doing the following:

1. Select “File”.
2. Select “Close Study” or “New Study”. If in Dashboard view, you can also do this by clicking on the
“Open new study” tab on the bottom left”

Quit DFexplore

3. This displays the initial Lists of Trials. You can now open another DFexplore trial by double clicking on
that trial.

NOTE: You can have more than one trial or multiple instances of the same trial open at the same time in
DFexplore. Multiple sessions of DFexplore can be opened to look at different patients.

Logging Out of DFexplore
1. Select “File”.
2. Select “Exit”.

3. You can also log out from the Dashboard View by clicking the “Quit DFexplore” tab on the bottom left:

Quit DFexplore
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4. |If after a period of inactivity you are automatically logged out, and the Auto Logout box appears. To
return to DFexplore, click “Login again.” To exit DFexplore, click “Exit.”

) DFexplore - Auto Logout lk ? X

o Due to inactivity, the connection has been logged out.

Exit

5. If you were automatically logged out, a dialog box appears the next time you log in to the same trial.
You may return to the same page you were on before you were logged out. Click “Resume” in the
dialog box to return to the last page. If you do not want to return to the last page click “Ignore”.

(2 DFexplore - Resume Previous Session ? X

0 The previous session was automatically logged out on
Tue Mar 12 17:18:13 2019
OK to resume the previous session?

Resume Ignore

DFsend

Some information cannot be entered electronically in DFexplore by the Center. Examples are:
e Quality of Life/Patient-completed questionnaires
e Reports: Pathology, Laboratory, Autopsy, etc.

e Medical Review query replies: These are queries generated by the IBCSG Medical Reviewers and
sent via email. They must be completed by hand.

This information must be submitted by DFsend (preferred) or fax. Once received and entered by the DMC,
these forms/reports are viewable, but not editable, in DFexplore.

Using DFsend

Be sure you have downloaded DFsend from https://www.ibcsgdmc.org/ibcsag/df/downloads.view .

NOTE: If you are using DFnavigator instead of DFexplore, you cannot use DFsend. You must send this
type of information via fax. The fax numbers are available on the DF Support page at
https://www.ibcsgdmc.org/ibcsa/df/documentation.view .

1. Login with the same server (explore.fstrf.org), username and password you use for DFexplore.

2. Document selection — The files must be saved in PDF format. Drag and drop one or more PDFs onto
the DFsend application box or click the Add button to use the standard file selection dialog.

NOTE: All pages must have the patient's Randomization ID Number and Center Code written clearly on
them or we are unable to identify the pages and they cannot be routed to the patient’s file.
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3. For Pathology and other reports, all other patient identifiers must be crossed out. Each trial has label
templates that can be printed and affixed to these types of reports, which can help the DMC identify
them. These label templates are available on the IBCSG web site.

4. Transmit - Click the Send button to send the selected PDFs to the study server. Enter your username
and password again for verification.

5. Confirmation - On completion, DFsend displays the transmission status of each PDF file. A green
checkmark indicates a successful transmission where as a red X indicates a failed transmission.

File  Help

df

B3 DFsend [d_mgreco@hosted-1.dfdiscover.com]

File Name

Status

Send Log

Total: 1 Sent: 1

Clear Log...

File Name
v

Status  Send Date

.DF.send.pdf sent  2019-03-21 15:43:27

6. Tracking - Each PDF transmission is logged by: username, date, time and transmission status. This
information is readily available when viewing pages in the DFexplore electronic patient binders. Past
transmissions can be reviewed in the DFsend application by selecting the option “Show log”.

User Support and Contact Information

For questions related to trial-specific issues, contact the DMC at the appropriate email address.

DFexplore resources, support, and documentation are available at: https://www.ibcsgdmc.org/ibcsg/df/

For fax confirmation and technical questions about DFexplore or connection issues, contact DMC user
support at datafax.user.support@fstrf.org or via phone at +716-834-0900 ext 7302.
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